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AP100US Version 8.03 Update & Release Notes 

 

Thank you for purchasing Amada’s AP100US! These release notes outline the new features or 
changes in the latest version of the software as well as information regarding updating to the 
current version. These modifications are in response to customer suggestions and feedback. 
Please remember that this AP100US CAD/CAM System is licensed software, and cannot be 
freely distributed. Please read the license agreement that accompanies the software. 
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Important  
This is a cumulative patch file for AP100US Version 8.03 only! The patch fixes the 
following problems and adds the enhancements outlined in this document. This service patch is 
intended for users currently running version 8.x. It is not intended to upgrade 7.x or earlier 
versions. You will render your current 7.x and earlier software inoperable if you 
attempt to use this patch!  

System Requirements  

Hardware  Description  

CPU  Intel Pentium IV 1.2GHZ, AMD DURON 1.2GHZ or higher 32 bit CPU.  

Memory  256MB of RAM (512MB or more recommended).  

Hard Disk  500MB of free hard disk space.  

Pointing Device  Mouse with wheel button.  

Video  Graphics card capable of supporting a minimum resolution of 1024x768. 
32MB Video RAM recommended with 32-bit colors.  

Protection Block  You cannot install or operate the software without the protection block.  

Multimedia  An optional sound card.  

Software  Description  

Operating 
System  

Windows 2000, Windows XP Professional 32bit, Windows 2003 Server, or 
Windows Vista 32bit 

Sentinel Driver  You must install the Sentinel Driver before you can install the AP100US 
System or optional software packages. (Note: Sentinel Driver 
automatically installs in most setups. If it does not, please refer to the 
PDF manual located on the CD-ROM or within the AP100US folder on the 
hard disk.)  

Network  For a network installation, the computer server must be running the 
server versions of Windows NT, Windows 2000, Windows XP Professional 
32bit, Windows 2003 Server, or Windows Vista 32bit. Also, it may be 
necessary to update the Sentinel Driver on the computer server.  

ADDITIONAL 
INFORMATION 

 

 Supports SolidWorks® 2006 and 2007, SolidEdge® 16, 18 and 19.  

 If both SolidWorks® and SolidEdge® are installed on the same 
system, an OLE integration conflict will occur in AP100US. 
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IMPORTANT! 
Make sure to completely read and understand the installation instructions. You can 
render your current software unusable if you perform the installation incorrectly! Back 
up your current set of machine drivers to a safe location. If you encounter any 
problems, please contact Technical Support.  You should develop an installation 
strategy before performing a new or upgrade installation.  

 Files you create in a new version of the AP100US System are not backward compatible 
with previous versions of the software.  

 You can import files created in previous versions of the AP100US System into the latest 
version. However, some versions require using the Convert File Names option found on 
the File menu to convert files that use the Virtual Directory file format to the 32-bit, 
long filename format. Please see Chapter 2: Getting Started, in the AP100US System 
Manual.  

 In some cases, you will have to use the File Stuff/Backup option in a previous version of 
the software to convert the file names. 

 

New Features - v8.03 
 The Sy2 file can now be saved into the SDDJ in the same way as the NC file is. 

 In addition to TK and Part Remover (PR) Unloading, the system now supports PR-C1 
Unloading. 

New Features - v8.01 
 

 The tool shape in the turret is now easier to identify. Selected tooling is highlighted to 
make them more accessible to the user.  

 Tools redraws will no longer slow down or disrupt Zoom and View Sequence changes, 
even when a large number of tools are placed and sequenced in the work area.  

 Amada TK & and Amada PR loaders now have default configuration values in the 
software, to simplify operation. Discover Dead Zone control, Tab Punchouts for 
improved sheet unloading, effective Auto Final Hit programming and Last Hit speed 
control for your PRII.  

 Output compatible .PRT files for FabriVISION systems. Now you can export native files 
for the FabriVISION machine.  

 Bending values previously had to be redefined each time they were used. Now, the 
most recent values are loaded by default in the Bend Parameters.  

 A “Title Display” button appears in the “Color and Style Parameters” tab within 
Preferences, allowing the user to control the title bar display in the AP100US CAD/CAM 
system frame window. With this button, the user may enable/disable file name display 
respectively. Also, the user is able to adjust the display order in title bar.  

 The Select Material File dialog box is now resizable and will keep the window size saved. 
A new Horizontal scroll toolbar is added into the dialog to help read items listed.  
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New Features - v8.0 
  Part Edge in common with Sheet Edge 

 If the part edges and sheet edges coincides, the overlapped edges will not be 
sequenced.  This new feature applies only to the punching machines when the "No Grid 
Parts" option has been enabled. 

 If part(s) are modified after the sheet had been generated, the AP100US CAD/CAM 
system will display a message and list out the changed part(s). The modified parts can 
be distinguished easily this way. 

 The AP100US CAD/CAM system can now load the SolidWorks® 3D parts directly without 
opening SolidWorks®. 3D part loaded in is unfolded automatically.  

 The AP100US CAD/CAM system now passes the cutting side flag to the driver, so the 
driver can tell if the cutting is inside, outside or on the pattern. 

 Network license runs on Windows Vista now, the user can set Network license for their 
CAD\CAM system which running on the new Vista platform.  

 New Undo/Redo menu added, which supports the undo/redo operations of Draw, Tool, 
and Sheet. Multiple steps of undo/redo are supported. 

 When designing a special tool, they keyed angle marker and special tool dead zone are 
now displayed so the user can easily determine their location during the design process, 
tell where the key angle is, and what the dead zone is. 

 Nesting data can be customized and exported to an Excel file, for integration into other 
applications. 

 Users can now set a gap value for the scribe tool. The gaps of the tool hits on different 
patterns are now uniform. The User can box select (or “fence select”) the patterns to be 
scribed. 

 Micro Joint tools now support common angle when sequencing.  

 The “Walk Thru Wizard” is now called “Sheet Wizard.” Sheet Wizard automatically 
checks micro joints, missing tool assignment, tool interferences, etc, and prompts the 
user to intervene. After reviewing the sheet, simply click save and return to the wizard 
to continue. As an option, generated NC code and sheets can be saved, and the sheet 
report can be viewed at the last step. 
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 Form shapes can be detected, if they exist on the face of a Solidworks® 3D model. The 
user can map the special shape with the special tool in AP100US. After OLE import, 
form features of Solidworks® become a group in AP100US and special tools can be 
assigned for the groups.  

 Support drivers generate the SY2 file, and each machine can have it’s own SY2 file 
format, easily customized for individual machines.  

 The user can now view the sheet information easily, using the Sheet Information 
window. Both Material Settings and CAM information are contained in the “Sheet 
Information” window. The user can input comments and specify a customer as well, to 
include with the sheet data.  

 The First Travel Range is for the user to specify and control the processing range of the 
reposition, so the sheet won’t become weak and the clamps can hold the sheet tightly 
when repositioning.  

 To have the AP100US CAD/CAM system integrated with FMS, certain files with defined 
formats can be created. 

 The Tool Preview has been moved from the output area and floating on the work area. 
Keyed angles display in the preview also. 

 Common cutting happens when the distance of the parts’ boundary equals to beam 
width. This applies to non-similar parts, too, not necessarily the same part. 

 Letters can be designated for station sizes freely, not just in an alphanumeric order. 
Letters can be swapped also. The letters which are occupied display in the red color. 

 The Part Info windows are now unified into one single window. The window is standard 
for all users, regardless of modules or packages used with the AP100US CAD/CAM 
system- there is no difference for IntelliNEST vs. Non-IntelliNEST users. 

New Features - v7.01 
 The system will get the Customer Data as well as Revision Data output from Part Info, 

and output it to the NC Code. 

 All sheets can have the remnant cut now, after nesting. 

 Now shows tools with angle as a setting in the turret, regardless if the setting in Tool 
menu is “From Turret” or “From Tool Inventory”. 

 The system will retain more tools when changing the machine file. 
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 The maximum (“max”) microjoint that can be added in the system is now expanded to 
250. 

New Features - v7.0 
 The Part Information window contains much more information than ever before. The 

part information is divided into two categories, i.e. generic and specific information. The 
generic information contains CAD Information, CAM Information and Production 
Information. The specific information contains Nesting Information. 

 The system can display the overtravel not only for the cutting machine, but also for the 
punching and combination machine. If you use the punching machine to process the 
sheet, the system can display the travel zones for the tools. If you use the combination 
machine, the system can display the cutting travel zone and punching travel zone for 
the Pre-Punch.  

 This function provides the user with easier and more intelligent tool assignment. The 
system will list all the matching tools for the pattern you select from the drop-down  
list automatically.  

 Many notch templates are available in the system. The user can select one template 
and set it as needed, which makes creating notches easier and quicker. You can assign 
a relief tool to process the notch holes. 

 This function allows you to add a flag on the pattern, indicating the tool on the pattern 
is fixed or the pattern can’t be assigned a tool when you load the part or machine.  

 This function provides you with a quick method to get all functions done by a few clicks 
of the mouse. This reduces too much work for the system settings and raises the 
production efficiency greatly. 

 This is an extended function in the nesting. The system can remove, sort and stack the 
machined parts from the machine. The position of last hit is determined by the  
system automatically. 

 The MJC is short for Micro Joint Cutter, which cuts the joint part in the unloaded sheet 
with joint. The IJP is short for Ink Jet Printer, which has a function to print part name, 
part size and other information on the part. There are two types of IJP device. One is 
combined with the MJC device, and the other is individual. 

 Duct Unfold creates unfolded parts of an air-duct. The User selects an air-duct shape 
from the list and enters the parameters of the shape, such as height, width, diameter or 
angle. The system calculates the unfolded shapes and transfers them into AP100US. 
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 The Cross-Section Unfold creates unfolded parts by rough sketched cross-section 
figures. The User roughly draws cross-sections and defines the parameters such as 
length, angle or bend allowance. The system calculates the unfolded shapes and 
transfers them into AP100US. 

 The Flange Unfold creates unfolded parts by adding some flanges on a specified base 
face. User draws a base face shape in AP100US, and then launches Flange Unfold. The 
Flange Unfold receives the base face shape and the user specifies some parametric 
flange shapes on it. The flange shapes are drawn by the same way as cross-section 
unfolding. User also can break the part by 3D edit functions if needed. The system 
calculates the unfolded shapes and transfers them into AP100US. 

 The Simulation module is software for validating NC programs created on AP100US. If 
you perform simulation before proceeding with an actual process, you can predict the 
time of each process, discover probable errors, and avoid any mishaps. This software 
also enables you to edit or create new NC programs. 

 The system imports the bending properties including the bend line length, the bend 
angle, the inner radius, the bend deduction, the bend direction and the bend order. 

 This function allows the Part Number, Programmer Name and Comments in the Part 
Information window to be output in the NC Code files. 

 This function allows you to control faces and also angles when OLE from SolidWorks®.  

 This function will help the new user to setup some necessary files conveniently, such as 
tool inventory, material files, material inventory etc. Then user can run and use the 
system to design and generate NC code after he installs the system for the first time.  
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FIXED ISSUES - v8.03 
 

Cutting Feature 

1. Parts in the sheet now run the Corner Radius feature without difficulty. 
 

Draw 

1. Previously, in Windows Vista repeating text in the Output box caused an “=” sign to appear. This has 
been corrected. 

 

Intellinest 

1. The preferred machine from the Part Info dialog box now copies correctly into the Nesting Info 
dialog.  

 

Punching Sequence 

1. The Microjoint Tool Sequence used in a keyed station can now be removed. 
 

2. When using the group command for the 2" squares of the part, out of range alarms do not occur. 
 

3. When the "Cut Entire Sheet Twice” checkbox is checked, the program no longer punches the regular 
punch hits twice. 

 

Reposition 

1. The Reprogrammable Clamps origin is now correct after reposition.  
 

Sheet 

1. “New Sheet” now brings in the Material Info\ Pierce Location\ Cutter Comp\ Beam Diameter value.  
 

2. When "Clear Database for New Sheet“ is unchecked, the Machine File and Material File are 
disabled.  

 

3. The Tool Line Nibble command now makes the correct sheet utilization.  
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Tool 

1. When opening a previously saved sheet, the "Tool Not Found in Inventory" error window does not 
display.  

 

View 

1. Mirroring parts on a sheet does not drop the Microjoints when switching from Part to Sheet View.  

 

FIXED ISSUES - v8.02 
 

Cutting Feature 

1. The Check Attributes feature now works correctly, and will give a proper message when 
lead-in/lead-out and cutting features collide with parts or geometry. 

 

Cutting Sequence 

1. Cutting Sequence, which was not optimized has now been fixed. 

 

Installation 

1. When installing an upgrade, the wrong default folders from previously installed versions 

would appear at times. This has been fixed in the current version.  

 

IntelliNest 

1. When Common Cutting is disabled in Machine>Edit Material>Process Type by selecting 

None, the beam diameter value in Common Cutting will be taken into account in the 

distance between parts. 

2. The “Include Leads/Features” setting in nesting now works smoothly with the Center 

Rectangle option. 

3. AP100US no longer pulls the micro joint length when Include Features is disabled. 
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Load File 

1. Multiple .dxf files can be dragged into AP100US simultaneously, and the program will 

still function normally. Previously the system would crash. 

2. A .dxf file can be saved into AP100US without crashing the system. 

3. Now PolyLines will group to a standard pattern when opening .dxf or .dwg files. 

 

Material 

1. The settings entered in Edit Material now remain when another tab is selected and 

before OK is clicked. Previously these settings would disappear if OK was not clicked. 

 

NC Code Generation 

1. When NC Code is generated without an extension, no extra dot appears behind the NC 

name. 

 

OLE Integration 

1. Lofted bends in SolidWorks OLE now works correctly. 

2. When SolidWorks is uninstalled, and then installed in another directory, Open&OLE will 

continue to work properly. Previously this action disabled Open&OLE. 

3. A single SLDPRT file using a v1.0.06 Transfaddin.dll now works in the current verison. 

 

Other 

1. Clamp Dead Zones are now correctly placed when the machine’s origin is in the upper 

left corner. 

2. The user can now run AP100US with a remote login. Previously this was not possible. 

3. The entire part can now be viewed in the zoom window. 
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4. When running the program on a Windows® Vista OS, viewing speed (0-9) now 

functions normally. 

5. Selecting “Process Geometry” now properly arranges the line side on the part 

perimeter. 

 

Punching Sequence 

1. The radius tool will not be shown when viewing sequence. 

2. The sequence will no longer stall when Microjoints and First Travel Range are removed. 

3. The system will now give an error message when the pattern is out of punching range. 

4. The sequence direction will remain correct when a sheet having the last AI tool is re-

sequenced. 

 

Sheet 

1. When making a new Sheet, the Clear Database was not using the default machine from 

the preferences, this has been fixed. 

2. The material file will change in accordance to a machine change in the New Sheet 

dialog. 

 

Template Report 

1. The Bridge Microjoint Tool will show up in Template Report. 

2. Bend Part Report no longer prints with a black background, and the Turret Report is not 

shaded. 

3. The full special tool name is now output on the template report. 

4. A new control in Print Setting has been added to enable zoom all or not before printing. 
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Tool 

1. The correct keyed angle now displays in Design Special Tool. Previously the incorrect 

angle displayed. 

2. An SP tool assigned in Part Mode will retain its angle after the part is rotated on a 

sheet. 

 

User Interface 

1. The Options Menu now turns off when the system is switched back to Modern Mode. 

2. The Save As > Options button in design special tool for .dxf and .dwg is no longer 

grayed out. 

View 

1. The gridded parts column now consistently displays on the sheet mode when Zoom in is 

enabled. 

FIXED ISSUES - v8.01 

1. AP100US 8.01 includes an improved preview system. The program now properly 
renders part file previews that would not display previously. 

2. The tool color function has been improved to display consistently, when it previously 
would not. 

3. When opening a part or zooming on a part, the system will not take the comment 
dimension into account if the comment is empty. 

4. Some patterns “jumped” from an original .DXF or .DWG file when the user set the unit 
as millimeter upon import. 

5. When the Display Cutting Direction option in Preferences is enabled, the cutting 
direction displays en when using the mouse wheel to zoom in and zoom out. 

6. Change tab size in Preference could not take effect when assigning Corner Notches. 
7. Previously, only one assembly would load in from the Open File menu. Now, the system 

can load multiple assemblies at the same time. 
8. When using "drag-and-drop“ function to open DXF file, the system previously would not 

consider the dimensions of the part file. 
9. Condition Ranges for Arcs were permanently checked before, within the Condition 

Tables of Material Information. 
10. When the Zoom window was previously open, the system would hang up if the user 

shifted programs while generating NC code. 
11. Open & OLE option in the File menu was previously unavailable when SolidWorks 

2008™ was installed. This feature is now available. 
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12. Both Open & OLE and OLE integration now works with SolidWorks 2008, in  
Windows Vista. 

13. The "Location on Sheets" and the "Sheet Layout Setting" values in the Machine Settings 
previously appeared be different by a factor of 25.4". This has been corrected. 

14. The NC Path now displays correctly. Previously, two slashes (“\\”) appeared in the 
 file path. 

15. The Online Tutorial has been updated for the new version of the AP100US  
CAD/CAM software. 

16. Sometimes the Last Tool Hit could not be added correctly in a sheet using PRII.  
This has been fixed. 

17. The last tool hit is only assigned to a line when using PRII. Previously, when using the 
PRII system, the last tool hits could be erroneously assigned to either a Line or an Arc. 

18. The system displays the auto unloading sequence view, now. 
19. New Sheet Information dialog will no longer pop up when popups are disabled. This can 

be changes in Display Mode Settings, within Preferences. 
20. Some special tools did not follow the Common Angle rule, previously. 
21. Some peripherals including the Amada PDC machine did not follow the Common Angle 

rule, previously. 
22. The tool hits placed on a radius corner were missing after auto sequencing. 
23. The template report now remains appropriately scaled upon launch. Previously, it would 

sometimes be affected by an active current zoom scale. 
24. Using the "Put In Same Station" option to replace a tool now works properly. An error 

would occur previously and the tool could not be put into the station. 
25. Smaller sized tools can be used in larger stations, If the user checks “Use Adapter” and 

properly assigns the tool. Previously, a smaller sized tool would become lost when 
loading the machine. 

26. When the user added a special tool, the Open dialog would close after adding the tool to 
the inventory. Now, the dialog remains open, to permit additional loads. 

27. When the user made a new sheet, the tools assigned to the station could disappear 
from the default machine and inventory, previously. 

28. Previously, in combination machines, users could only assign "last tool hit" to finish a 
line. Now, "last cut" is also available. 

29. If a material or machine name was too long, the system would only show part of the 
name on the program title bar, previously. 

30. The character limit for the built-in Dynamic Calculator has been increased to 
accommodate more than six characters, allowing much more complicated calculations. 

31. In previous versions of AP100US, the program would end the Separate command after 
a part was separated. Now the function remains selected and available. 

32. The correct punch sequence and cut sequence features should be available to users 
within the menus. Previously, some items were not listed in the menu. 

33. Parts with tabs will not list in the Parts without Microjoints column in Sheet Wizard. 
34. Hole sequencing has been improved when using NC View in Sheet Wizard. 
35. The system would crash after customizing toolbars by deleting icons from Standard 

toolbar. 
36. When two punching machines were loaded one after the other, the Overtravel lines did 

not refresh until Machine Info was selected and closed. 
37. The system should show “min dead zone” and “active station’s dead zone” when 
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inquiring tools and viewing sequence. 
38. The “convert dialog” display was too small. 
39. The system would show different dimensions or parts in part mode when clicking the 

different part names on the part list dialog.  The part and part name on the window 
caption does not automatically change. 

40. Close pull down menus would disrupt the display. 
41. When loading DXF, IGA, DWG or IGS files, the system would ask the user to load sheet 

size and material thickness. 
42. DXF files loaded through the Walk-Through Wizard will have a line side problem; the 

part should be processed. 
43. Added a switch to turn off the pop-up message for applying material and sheet 

thickness. 
44. “Apply material thickness and sheet size” system message would appear when loading 

old part, DXF file, DWG files, etc.  
45. DXF file output from the system would mistakenly create open entities. 
46. “Cancel” button missing in the New Part dialog. 
47. When selecting Grid, clicking on the part and then centering Grid-X to put the part on 

the center of the sheet, the system  moved the part to the far right side of the sheet. 
48. When start point moved to the part corner, prepunch would not move with the start 

point and stay in the original place. 
49. Due to an angle placement conflict, the part did not nest with the angle set in the Part 

Information dialog and the parts were lost in the nesting report. 
50. An error message appeared when the user attempted to complete nesting jobs. 
51. When updating the sheet after nesting, the cutoff line on the sheet could not be deleted 

or edited. 
52. After nesting, the tools on the part would be lost and wrong tools would be assigned to 

the pattern. 
53. Some parameter values were multiplied 25.4 times larger when displayed in the Tool 

Assignment dialog, if units converted from inches to millimeters. 
54. When using a special tool as a Wheel tool, the system did not pass the correct value to 

the driver. 
55. The Cancel button, which showed up during generating NC code, did not do anything. 
56. The decimal value could not be entered in the Pop-Up dialog when generating NC code. 
57. Generating NC code off some sheets were excessively slow, and have been optimized. 
58. The Overtravel display of this sheet did not refresh when performing View Sequence. 
59. System would crash when set to auto sequence with cup and stack suction cups on the 

PRUL machine. 
60. The system could not print variables of the Tool conditions such as “Feed  Rate 1-4” in 

the template report. 
61. The table format in the Hole Chart template should be rearranged to support one hole 

in one line. 
62. When placing tool hits and then using “Expand All Items” to select other tools to place, 
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the tool hits placed were always the last one selected. 
63. “Check for Tool Interference” could not find the tool interference in some parts. 
64. Place Special Tool Hits would have ghost image problems with drawings in black 

backgrounds and white patterns. 
65. When turning on common tool punch, Remove DUPLICATE HITS did not remove the 

Square tool double hits in this sheet. 
66. Assigning a special tool to the closed line, the system could hang up. 
67. When entering the string value into some items under Edit Material\CNC Code, pressing 

Enter button would change the string value into float value. 
68. After clicking on Edit Reposition Amount the user was able to right click and toggle 

between  
69. AutoCAD could not open .DXF files converted from .PRT files, using the export program 

[expgr.exe]. 
70. Under Windows 2000 Operation System, the part could not be seen in the 

Inquire/Correct window in CAD. 
71. IMPORT/EXPORT modules would not work correctly with Power User permissions set on 

NTFS hard drive partitions. 
72. The “Finish” button did not work under the OLE Preview dialog, when the angle was 

selected. 
73. There would be one additional ellipse when importing this part into the system. 
74. Part name would appear when pressing F10 or "Save As" but the part name would NOT 

be the file name box after OLE import 
75. Using Open and OLE from the File menu, the user could not get the Preview for OLE 

dialog 
76. The user could not tell which part was selected under Auto Tooling Options Dialog. 
77. Added a switch to the Preferences to turn off the pop-up message for applying material 

and sheet thickness. 
78. Unable to show all dimensions because the window was zoomed in too close. 
79. When outputting BMP file, the system would crash. 
80. If the angle was rotated in the Part Info dialog and the user switched the view, the part 

would rotate off the sheet.  
81. Area AutoGrid function had layout conflicts. 
82. The pop up dialog for generating NC code would create errors for any item displayed 

behind it. 
83. When entering Pattern Properties and other details, values would "round up" the input 

data before being saved into the database, after the user pressed OK or Tab button to 
accept input values. 

84. Place the ULX loader and the storage table at the left side by using ULXSIDE=1. 
85. The microjoints on this part would be lost when doing auto sequence. 
86. The system would crash when switching to view part mode by clicking Part button. 
87. With “Use Subroutines and Macro On” checked, the part gird on the sheet could not 

perform prepierce. 
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88. Changed Part Width and Part Height into Part size X and Part size Y under the dialog for 
New Part and New Sheet. 

89. DimZ should be changed to “other name” in the Setup Wizard. 
90. After the installation, the icons on the desktop would mess up. 

Update Installation via Download  

Updating the AP100US CAD/CAM System via http://amadasupport.com 

Note: Do not unzip the service release files to your default AP100US  
CAD/CAM directory 

To update the AP100US CAD/CAM system using download: 

1. Run the Windows Explorer and navigate to the folder C: \FabriWIN or the AP100US 
CAD/CAM system folder you specified when you installed it.  

2. Create a temporary folder, such as C:\Temp and unzip AP100US8.x_8.03.exe to it. 
This will create to sub-folders C:\Temp\FabriWIN and C:\Temp\System32 

3. Copy backup.bat in “:\Temp\FabriWIN to C:\FabriWIN or the AP100US CAD/CAM 
system folder and run it.  

4. Copy the files in C:\temp\system32 to the default system folder of your operating 
system, like “C:\Windows\System32”.  

5. Copy the unzipped files in “C:\temp\FabriWIN” to the AP100US CAD/CAM system 
main folder you previously specified. The default folder is C:\AP100US\FabriWIN. 

6. You have updated your AP100US CAD/CAM system and can run it.  

 
 
AP100US CAD/CAM Updated File List 

Name Path
Launch Internet Explorer Browser.lnk  

Edition 

AppUpdate.exe C:\AP100US\FabriWIN 1.0.0.1 

AppUpdate.exe.config C:\AP100US\FabriWIN  

backup.bat C:\AP100US\FabriWIN  

cadcam.exe C:\AP100US\FabriWIN 12.0.3.11 

ConvertSPT.dll C: \AP100US\FabriWIN 1.0.0.5 
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DD_Alloc_2.05_6.dll System32 2.5.2.0 

DD_Db_2.05_6.dll System32 2.5.2.0 

DD_DbRoot_2.05_6.dll System32 2.5.2.0 

DD_Ge_2.05_6.dll System32 2.5.2.0 

DD_Gi_2.05_6.dll System32 2.5.2.0 

DD_Root_2.05_6.dll System32 2.5.2.0 

dxfigs.dll  1.1.0.22 

DxfigsWrapper.dll System32 1.0.0.17 

ExpImpDxfDwg.dll System32 1.0.0.22 

fwblock.dll System32 1.0.0.6 

FW11res.dll C:\AP100US\FabriWIN 12.0.3.11 

FWBlock.exe C:\AP100US\FabriWIN 8.0.0.5 

FWBlockProxy.exe C:\AP100US\FabriWIN 1.0.0.18 

FWCBPRO675.dll C: \AP100US\FabriWIN 6.75.0.9 

FwDom.dll C:\AP100US\FabriWIN 2.0.0.7 

Microsoft.Web.Services3.dll C:\AP100US\FabriWIN 3.0.5305.0 

Msconv.dll C: \AP100US\FabriWIN 1.1.0.12 

MSNestExpert.dll C:\AP100US\FabriWIN 0.0.0.45 

NetworkBlockConfig.exe C:\AP100US\FabriWIN 1.0.0.7 

Nflnest.dll C:\AP100US\FabriWIN 9.2.5.19 
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OldFWIO.dll C:\AP100US\FabriWIN 3.0.0.1 

PartView.dll C: \AP100US\FabriWIN 1.0.3.15 

Sldworks.dll C:\AP100US\FabriWIN 1.0.1.25 

StationDesign.dll C:\AP100US\FabriWIN 1.0.1.6 

TemplateReport.exe C:\AP100US\FabriWIN 1.1.21.0 

TemplateReportBase.dll C:\AP100US\FabriWIN 1.1.19.0 

TKUtil.dll C: \AP100US\FabriWIN 2.0.0.3 

ToolInvFactory.dll C:\AP100US\FabriWIN 1.0.0.25 

workbook.xls C:\AP100US\FabriWIN\JOBS  

 
 

Updating Unfold 3D  

To update the Unfold 3D:  

1. Run the Windows Explorer and navigate to the folder C:\Unfold3D\FABRIWIN or the 
folder you specified when you installed it.  

2. Create a temporary folder, such as "C:\Temp" and unzip AP3Dand2D.exe to it.  

3. Copy backup.bat in "C:\Temp" to C:\Unfold3D\FabriWIN or the folder you specified 
before and run it.  

4. Copy the unzipped files in c:\temp\FabriWIN to the AP100US CAD/CAM system main 
folder you previously specified. The default folder is C:\FabriWIN.  

5. You have updated your Unfold3D modules and can run 3D applications.  

 

Unfold 3D Updated File List 

Name  Path Edition 

MSConv.dll  C:\Unfold3D\FabriWIN  1.1.0.12  
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Update Installation via Online Update 
 If you have high-speed access to the Internet, you can use the 
Online Update utility to check for software updates on a regular 
basis.  Simply select "Online Update" from the Help Menu to 
begin.   

To use Online Update: 

1. Select Online Update from the AP100US CAD/CAM system 
submenu. A warning message will appear, instructing you 
to close all AP100US CAD/CAM system applications. If 
necessary, exit any open AP100US CAD/CAM System 
applications. 

2. Click Next in the message dialog if you want to proceed with the update. Click Cancel to 
exit without updating the software. 

3. If you click Next , the Online Update window appears and checks for newer versions. 

4. If updates are available install to begin otherwise click cancel to exit without updating. 

5. Updates will install automatically and when complete click Finish to exit the Update. 
 
 

Update Installation via CD Install 

Note: If you select install a new copy of this product, the installation utility will 
install the update as a separate product in an alternate folder, rather than update the 
software in the default program folder. For more detailed instruction refer to the 
CADCAM Installation Guide on New and Update Installation Procedures. 

To perform an Update Installation via CD:  
1. Insert the product installation CD into the CD-ROM drive. The Qualifying Product(s) 

Detected window appears. The message in the window informs you that Setup has 
detected the following product(s) on your computer that qualify for the update.  

 
2. Select Update the product selected below and click Next > to continue.  

a. Note: If you select Install a new copy of this product, the installation utility will 
install the update as a separate product in an alternate folder, rather than 
update the software in the default program folder. Click Next > to continue.  

 
3. The Preparing Setup window appears. Wait until the file backup process is completed. 

 
4. The page for Language selection appears. Select a preferred language and click Next> 

to continue. 
 

5. The page for UI customization appears. Select a preference from “Windows Style,” 
“Start Mode,” or “Sheet Wizard” and click Next > to continue.  
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6. The Welcome window appears. Select Modify, Repair or Remove and click Next >. 

 
7. The Components selection window appears. The user should select the components to 

reinstall. Click Next > to continue.  
 

8. The “Parameter Settings” dialog comes up. The user should confirm the all the settings 
in the dialog and change them if necessary. Click Next > in the dialog to continue.  

 
9. The “3D Directory Settings” dialog comes up. The user should confirm all the settings in 

the dialog and change them if necessary. Click Next > in the dialog to continue.  
 

10. The “Select Program Folder” window appears. The user should specify a program folder 
for the installation. Click Next > to continue.  

 
11. The Start Copying Files window appears. The installation utility begins to copy files to 

your computer system.  
 

12. After the Copying Files process is completed, the License Setting Window appears. 
License configuration should be done in this window. Click Next > to continue.  

 
13. The “Maintenance Complete” window appears. Click Finish to complete the Update.  

 
 
 
 

Contact Information  
Amada America Inc.  
7025 Firestone Blvd.  
Buena Park, CA 90621  
1-800-254-7532  
Ap100usSupport@amada.com 
 
For more information about Amada and its line of products, please visit www.amada.com.  

Microsoft Windows 2000® and Windows XP® are registered trademarks or trademarks of 
Microsoft Corporation in the United States and other countries.  


